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Preface

This User Guide has been implemented by Boot & Work, S.L. working

under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience

This User Guide is intended for the following audience:

e Persons in charge of introducing automation devices.
e Persons who design automation systems.

e Persons who install or connect automation devices.

e Persons who manage working automation installation.

& Warnings:

Unused pins should not be connected. Ignoring the directive may damage the
controller.

Improper use of this product may severely damage the controller.

Refer to the controller’s User Guide regarding wiring considerations.

Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.

Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

The ESP32 ETHERNET&WIFI&BLUETOOTH PLCFamily PLCs are Open Type Controllers. It
is required that you install the ESP32 ETHERNET&WIFI&BLUETOOTH PLCPLC in a
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housing, cabinet, or electric control room. Entry to the housing, cabinet, or electric
control room should be limited to authorized personnel. Failure to follow these
installation requirements could result in severe personal injury and/or property
damage. Always follow these requirements when installing  ESP32
ETHERNET&WIFI&BLUETOOTH PLC family PLCs.

e In case of installation or maintenance of the ESP32 ETHERNET&WIFI&BLUETOOTH PLC
please follow the instructions marked in the Installation and Maintenance section.

e Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

& Avertissements:

e Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le controleur.

e Une utilisation incorrecte de ce produit peut endommager gravement le contréleur.

e Reportez-vous au Guide de l'utilisateur du contréleur pour les considérations de
cablage.

e Avant d’utiliser ce produit, il incombe a I'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui 'accompagne.

e La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

e La maintenance doit étre effectuée avec I'’équipement hors service et déconnectée de
toutes les sources d'alimentation.

e Faites attention lors de I'entretien des composants sensibles a I'électricité statique.
Les recommandations du fabricant pour ces composants doivent étre suivies.

e Les automates de la famille ESP32 ETHERNET&WIFI&BLUETOOTH PLCsont des
contréleurs de type ouvert. Il est nécessaire d'installer I'automate ESP32
ETHERNET&WIFI&BLUETOOTH PLCdans un boitier, une armoire ou une salle de
controle électrique. L'accés au boitier, a lI'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de la
famille ESP32 ETHERNET&WIFI&BLUETOOTH.

e En cas d'installation ou de maintenance du ESP32 ETHERNET&WIFI&BLUETOOTH PLC,
veuillez suivre les instructions indiquées dans la section Installation et Maintenance.

e Ne débranchez pas I'équipement en présence d'une atmosphere inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphere



Rev. 3:19-11-2021

inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.

Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

e Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

e Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.
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Intended use or of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It
must respect the permissible ambient conditions. You should also follow the indications
and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.

Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.

6
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When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: — Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection technology
- Response times of the controller and drive — Operating and/or ambient conditions not
within the scope of the specification — Condensation / conductive contamination -
Parameterization, programming, cabling, and installation errors — Use of radio devices /
cellular phones in the immediate vicinity of the controller — External influences /
damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: - Component malfunctions — Software errors — Operating and/or
ambient conditions not within the scope of the specification — External
influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions -
Influence of electrostatic charging — Induction of voltages in moving motors — Operating
and/or ambient conditions not within the scope of the specification - Condensation /
conductive contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions as a result of improper operation
of the system and/or failure to dispose of components safely and correctly.
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’'S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR
REPAIR.
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1 General Description ESP32 ETHERNET&WIFI&BLUETOOTH

PLC FAMILY Product

1.1 Zones Table

Zones Table

Model Zone 0 Zone A Zone B Zone C
ESP32 PLC 21+ Analog / Digital - -
ESP32 PLC 42+ Analog / Digital Analog / Digital -
ESP32 PLC 58+ Analog / Digital Analog [ Digital Analog / Digital
ESP32 PLC 19R+ Relay - -
ESP32 PLC 38R+ Relay Relay -
ESP32 PLC 57R+ Relay Relay Relay
ESP32 PLC 38AR+ Analog / Digital Relay -
ESP32 PLC 53ARR+ Analog / Digital Relay Relay
ESP32 PLC 57AAR+ Analog / Digital Analog / Digital Relay
ESP32 PLC 54ARA+ Analog / Digital Relay Analog / Digital
ESP32 PLC 50RRA+ Relay Relay Analog / Digital

12
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1.2 Measures Table

Measures Table
Model Height (mm) Width (mm) Depth (mm) Weight (g)
ESP32 PLC 21+ 119.5 70.1 101 380
ESP32 PLC 42+ 119.5 947 101 490
ESP32 PLC 58+ 1195 1193 101 600
ESP32 PLC 19R+ 1195 701 101 380
ESP32 PLC 38R+ 1195 947 101 490
ESP32 PLC 57R+ 1195 1193 101 600
ESP32 PLC 38AR+ 1195 947 101 490
ESP32 PLC 53ARR+ 1195 1193 101 600
ESP32 PLC 57AAR+ 1195 1193 101 600
ESP32 PLC 54ARA+ 1195 1193 101 600
ESP32 PLC 50RRA+ 119.5 119.3 101 600

13
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1.3  Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is
important to understand this nomenclature.

The nomenclature to differentiate the zones is based on Alphanumeric values, being O
the internal communication shield and A, B or C the I/Os or Relay shield.

s o

- i
W oo W W o wow
E 5855
Nggl\l nd NggN
<o OO 000 o<

e The inputs in the zone A/B/C are named IX.X, being X any number suitable in
the Shield. Outputs are named as QX.X.

1.4  Zone Distribution

Relay Relay Relay
I

COMMUNICATION

ZONE ZONEA | — | ZONEB |— | ZONEC

—{ Analog — Analog — Analog
- ogtal |

This is the possible zones scheme, whether the zone is Analog/Digital or Relay
depends on your device, you can consult it on the Zones Table. The distribution of the
different features that provide the Raspberry PLC Family are described below.

14
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1.5 Zone Features

Shield Zone Characteristics

(1x) Ethernet

(1x) WiFi

(1x) BLE

(1x) VN/VP

(2x) Serial TTL
Communication Shield | (1x) I12C

(1x) RS-232

(1x) HALF Duplex RS-485
(1x) SPI external Port
(1x) RTC

(1x) uSD Socket

13 Inputs: 13 Digital inputs, 6 of which can work as Analog Input

Analog Shield 8 Outputs: 8 Digital Outputs, 3 of which can work as Analog Output

6 Inputs: 6 Digital Inputs, 4 of which can work as Analog Input

Relay Shield 11 Outputs: 8 Relay Outputs

3 Digital Outputs, 3 of which can work as Analog Output

15
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1.6  Mechanical dimensions

| B — ¢ 7

119.5

-

*NOTE: This device includes one 2.4GHz antenna and one 5G antenna (for the 5G option), and
both have a length of 5¢cm.

16
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ESP32 ETHERNET&WIFI&BLUETOOTH PLC FAMILY

MODEL TYPE Controller General Specifications Information
Fuse protection (2.5A)
Input Voltage 12};2:1\/% Polarity protection
24 Vdc
Input rated voltage —
Rated Power 30W
| max. 1.5A
Size Consult the 1.6 Measure Table section
Clock Speed External: 240 MHz Internal: 8 MHz
External Flash AMB
Memory
SRAM 520 KB
ROM 448 KB

Communications

12C — Ethernet Port — WiFi — BLE — RS485 (HD) —
RS232 — SPI — SerialTTL — VN/VP

Max232-Max485-W5500

USB consideration!

Only meant for uploading or debugging, not
always connected as a serial in a project!

Cannot be working in a final
application

An/Dig Input 10bit
(0-10Vcce)

0 to 10Vac
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vac

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc

Digital Isolated Input
(24Vce)

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc

* Interrupt isolated
Input HS (24vcc)

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24Vdc

Analog Output 8bit
(0-10Vcce)

0 to 10Vac
| max: 20 mA
Separated PCB ground
Rated Voltage: 10Vac

Digital Isolated
Output (24vcc)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410 mA

Relay Output (220Vac)

220V Vac
I max: 5A
Galvanic Isolation
Diode protected for Relay

17
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PWM lIsolated Output
8bit (24vcc)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Expandability

I12C - 127 elements - Serial Port RS232/RS485

* By using this type of signal can no longer use Digital signal

(24vdc)

2 Technical Specifications:

2.1

General Specifications:

Item

ESP32 ETHERNET&WIFI&BLUETOOTH PLC

Power supply
voltage

DC power supply

12to 24Vdc ===

Operating
voltage range

DC power supply

11.4t025.4vdc ===

Power

consumption | PC Power supply | 30W max.
Power — SUPPIY | spvge ===

External voltage

power supply Power Supply —

output capacity

Insulation resistance

20MQ min.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength

2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the
external AC terminals and the protective ground terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage)

-20° to 60°C

Power supply holding time

2ms min.

Weight

See the measure table.

18
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Board

ESP32-WROOM-32UE

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform
composed of a programming language. (We recommend minimum version 1.8.13).
http://arduino.cc/en/Tutorial/HomePage

Microcontroller ESP32
External Flash Memory 4MB
Program capacity (SRAM) 520KB
SRAM in RTC 16KB
Clock Speed 40MHz

2.3  Symbology

Table that includes all the symbology that is used in the serigraph of the ESP32
ETHERNET&WIFI&BLUETOOTH PLC

I/Os Analog/Digital PLUS:

Symbol Standard No. / Standard Symbol Meaning
Standard Title Reference No. /
Symbol Title
IEC 60417 / 5031 / Direct Indicates that the equipment is
] Graphical symbols Current suitable for direct current only;
I = for use on to identify relevant terminals
equipment
IEC 60417 / 5032 / Alternating | Indicates that the equipment is
Graphical symbols Current suitable for alternating current
for use on only; to identify relevant
N~ equipment terminals
IEC 60417/ 5130/ Pulse To identify the control by
Graphical symbols General which a pulse is started.
for use on
equipment
IEC 60417/ 5017 / Earth, To identify an earth (ground)
Graphical symbols Ground terminal in cases where
for use on neither the symbol 5018 nor
— equipment 5019 is explicily required.

19
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IEC 60417 / 5115/ Slgnal lamp To identify the switch by
Graphical symbols means of which the signal
for use on lamp(s) is (are) switched on or
equipment off.
Medical Devices CE Marking CE marking indicates that a
Directive product complies with
93/42/EEC applicable European Union
regulations
ISO 7000/ 0434B / Indicates a potentially
Graphical symbols | Warning symbol hazardous situation which, if
for use on not avoided, could result in
equipment death or serious injury
ISO 7000/ 5036 / Dangerous To indicate hazards arising
Graphical symbols Voltage from dangerous voltages
for use on
equipment

3 Precautions

Read this manual before attempting to use the ESP32 ETHERNET&WIFI&BLUETOOTH PLC and
follow its descriptions for reference during operation.

3.1

ESP32 Board

This version of 10 1/0s Digital Module PLCs include ESP32 Board as controller.

3.2

Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3

The user

General Precautions

performance specifications described in this manual.

must operate ESP32 ETHERNET&WIFI&BLUETOOTH PLC according to the

Before using ESP32 ETHERNET&WIFI&BLUETOOTH PLC under different conditions from what
has been specified in this manual or integrating ESP32 ETHERNET&WIFI&BLUETOOTH PLC to
nuclear control systems, railroad systems, aviation systems, vehicles, combustion systems,
medical equipment, amusement machines, safety equipment and other systems, machines,
and equipment that may have a serious influence on lives and property if used improperly,
consult your INDUSTRIAL SHIELDS representative. Ensure that the rating and performance
characteristics of ESP32 ETHERNET&WIFI&BLUETOOTH PLC are sufficient for the systems,
machines, and equipment, and be sure to provide the systems, machines, and equipment
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double safety mechanisms. This manual provides information for programming and operating
the ESP32 ETHERNET&WIFI&BLUETOOTH.

4 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Industrial Shields provides boards for programming the PLCs much easier. Basically, it is no
needed to define the pins and if those pins are inputs or outputs. Everything is set up
automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:

Arduino IDE 1.8.13 or above (better to always have the latest version).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences X
Settings  Network:
Sketchbool: location:

Ci\Users'Albert|DocumentsiArduino Browse

Editor language: English (English) ~ | (requires restart of Arduino)
Editor font size: 15
Interface scale: Automatic 100 5 %  (requires restart of Arduing)

Show verbose output during: compilation upload
Campiler warnings: Nore v

[(pisplay line numbers

[CJEnable code Folding

Verify code after upload

[ use external editor

Check for updates on startup

Update sketch files to new extension on save (.pds -> .ino)
Save when verifying or uploading

Additional Boards Manager URLs:  hittp ://apps.industrialshields. com/main/arduino/boards package_industrialshields_inde;| 2]

More prefe ces can be edited directly in the file
C:'\Usel ppDatat_ocal\Arduino 15\preferences. txt
(edit only when Arduino is nat running)

Ok Cancel

2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.
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4. Tools -> Board: ... -> Boards Manager. Search for the industrialshields-esp32 board and
install the last version (it must be from the version 2.0.2 minimum):

@ Gestor de tarjetas

Tipo | Todos ~ | |industrial shields

industrialshields-esp32
wversion 2.0.2 INSTALLED
Tarjetas incluidas en este paguete

WiFi/BT module, 10 IOs PLC family, ESP32 PLC family.
Cnline Help
More Info

Seleccione versidn Instalar Eliminar
Seleccione versidn
aavr

D
ke paguete

1.

W

Cerrar

Following these steps, you will be able to see now the Industrial Shields Boards:

Auto Formato

Archivo de programa.

Reparar codificacion & Recargar.
trl+ Mayis o1
i+ MaylseM
SR O run once:

WIFI101 / WIFININA Firmware Updater

Placa: “ESP32 PLC Family”

Model: "ESP32 PLC 2110+

Version: "v3

Gestor de tarjetas.
Arduino AVR Boards
Industrial Shields boards

xtension module 1: “Ninguno™ Industrial Shields ESP32 3

10105 PLC Family
Extension module 2: "Ninguno’ Industrial Shields megaAVR Boards > [l ESP32 PLC Family

Obten informacion de la piaca

Programador
Quemar Bootioader
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Once it is selected the ESP32 PLC Family, an extra option will appear on Tools.

There, it can be selected the exact model for every family.

Also, there are some examples of programming in File -> Examples -> ESP32 PLC Family
Furthermore, there are some extra libraries that can be found in Industrial Shields github.

https://github.com/IndustrialShields/

5 How to connect ESP32 PLC to PC

- Connect micro-USB port from PLC to PC.

NOTE:
ESP32 ETHERNET&WIFI&BLUETOOTH PLC
uses micro-USB type B cable.

- Open Arduino IDE interface:

- Select Industrial Shields boards -> ESP32 PLC Family

, to run once:
WIFi101 / WIFININA Firmware Updater

Placa: “ESP32 PLC Family”
Model: *ESP32 PLC 21 10+
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- Select the correct ESP32 PLC Model:

© sketch_nov18a Arduino 18.13 - o
Archivo Editar Programa Herramientas Ayuda

Auto Formato

Archivo de programa.

Reparar codificacion & Recargar.

Administrar Bibliotecas. Ctri+Mayus+!

Monitor Serie Curt+Mayus+M

Serial Plotter +Mayus+L run once:

WIFI101 / WIFININA Firmware Updater

Placa: “ESP32 PLC Family
Modet: *ESP32 PLC 21 10+" ESP32 PLC

Version: "v3" ESP32 PLC 19R 10+
Extension module 1: "Ninguno™ ESP32 PLC 2110+
Extension module 2: "Ninguno’ ESP32 PLC 38AR 10+

Obtén informacion de (a piaca peatedly
£SP32 PLC SORRA 10+

ESP32 PLC S3ARR 10+

ESP32 PLC S4ARA 10+

Programador
Quemar Bootioader

ESP32 PLC STR 10+
ESP32 PLC 5810+

- Select the latest version.

© sketch_nov18a Arduino 1813 = o

Archivo Editar Programa Herramientas Ayuda
Auto Formato
Archivo de programa.
Reparar codificacion & Recargar
Administrar Bibliotecas. Ctrl+Mayts+|
Monitor Serie Curt+Mayus+M
Serial Ploteer CrteMayisel to run once:
WIFI101 / WIFININA Firmware Updater
Placa: “ESP32 PLC Family
Model: *ESP32 PLC 21 10+
Version: "v3"
Extension module 1: “Ninguno™
Extension module 2: "Ninguno™

Obten informacion de Ia placa

Programador
Quemar Bootloader
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Select the right extension modules (if required: if you have purchased the device with
them by default).

© s Arduino 1813 - o X

el O run once:
WIFIT01 / WIFININA Firmware Updater

Placa: “ESP32 PLC Family

to rup.»€peatedly:

- Select the correct port for your board.

6 How to connect PLC to power supply

- ESP32 ETHERNET&WIFI&BLUETOOTH PLC is 12-24Vdc supplied. IMPORTANT: The
polarity IS NOT REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

_ —

=g | ( )
o 2> ND POWER SUPPLY
w < [ JIND |
= & |
= 8 ' GND
" :J | \\/d: | n \24 Vee JI

————— —
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- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm

DIN Rail:

-12Vdc / 24Vdc

-2.5A
-30W

Industrial Shields power supplies provide parallel

operation, overvoltage protection, and overcurrent
protection. There is a LED inductor for power status,

the power supply is certified according to UL.

Rev. 3:19-11-2021

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types

of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-

1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of
the equipment must be separated from the dangerous voltage cables.

7 ESP32 ETHERNET&WIFI&BLUETOOTH PLC Pinout

7.1 1/0s Table
10s Table
Model Reference Analog Input | Digital Isolated Input | Digital Isolated Output | Digital/Analogic Qutput | Relay Output
21+ 01200X000200 6 7 5 3 0
42+ 01200X000400 12 14 10 6 0
58+ 01200X000600 16 21 15 9 0
19R 01200X000100 4 2 0 3 8
38R 01200X000300 8 4 0 6 16
57R 01200X000500 12 8 0 9 24
38AR 01200X000700 10 9 5 6 8
57TAAR 01200X000800 16 16 10 9 8
S50RRA 01200X000900 12 11 5 9 16
53ARR 01200X001000 14 11 5 9 16
54ARA 01200X001100 14 16 10 9 8

26



Rev. 3:19-11-2021

7.2 0 Zone connection

Base
(common unit) -]
A Zone
5
e g
o >
o
3.3vdc -
5vdc - Communication Pins
GND -
3.3vdc -
5Vdc -
GND -
SCL GPIO 22
SDA GPIO 21
GND -
TX1 TX1
RX1 RX1
GND -
TX2 -
RX2 -
VN SENS VN (R
VP SENS VP = Configuration Switch* (see section 8 for
AB; 22322 3 ‘ configuring the communications.
GND RS485 — Enabling communications disables some
e} GPIO 19 1 1/Os)
Sl GPIO 23
SCK GPIO 18
GPIO O -
5vdc 5V
TX RS232
RX RS232
C
Base
(common unit)
A Zone
' MicroUSB Type B “Program”
c
@) :s
7 2
o >
T
vdc Power Supply
GND GND
e ¥ Vdc
£ GND
O ]
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RESET button

!

- == ,

Ethernet RTC battery microSD Socket
(CR1220) (behind the lid)
(behind the lid)

Power LED

NOTE: Slots or indications related to the Extension modules are clearly pointed out on
the serigraphy of the device.
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Analog/Digital Zone connection (I/0s)

7.3
X Zone
S 8
208 5
og ¢ =
%) c 3]
g8 :
T
1X.12 Analog / Digital In
IX.11 Analog / Digital In
1X.10 Analog / Digital In
IX.9 Analog / Digita In
IX.8 Analog / Digital In
IX.7 Analog / Digital In
(-)IX.6 GND 10.6
IX.6/INT* Interrupt X In
(-)IX.5 GND 10.5
IX.5/INT? Interrupt X In
(-)IX.4 GND 10.4
IX.4 Digital Input
(-)IX.3 GND 10.3
IX.3 Digital Input
(-)IX.2 GND 10.2
IX.2 Digital Input
(-)IX.1 GND 10.1
IX.1 Digital Input
(-)IX.0 GND 10.0
IX.0 Digital Input
Top Zone

Fd
n

=

o g

-
o

Led indicator I/Os state

=

I

3ng
WAd/B

=
&

X Zone

£9 8 c
283 2

3 £ g

=}

g 8 2

GND GND

AX.72 Analog Out

AX.62 Analog Out

AX.52 Analog Out
Q/Vdc External Isolated Out Vdc
COM(-) External Isolated Out GND
QX.72 Digital/PWM Out
QX.62 Digital/PWM Out
QX.52 Digital/PWM Out
QX.4 Digital Out

QX.3 Digital Out

QX.2 Digital Out

QX.1 Digital Out

QX.0 Digital Out

—T
Anal

lo

— 0 1o 10Vdc

Digital
5 to 24Voc

<o
Digital:
5 to 24Vdc

! See the Interrupt Equivalence Table.
2 See Section 8 to select the correct configuration for outputs.

Rev. 3:19-11-2021

Analog / Digital Inputs

Digital / Interrupt Inputs (isolated)

Digital Inputs (isolated)

Configuration Switch
(See Section 8 to select the correct
configuration for outputs)

Analog Outputs
Voltage Supply/Reference for

Digital/PWM Outputs (isolated)
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Relay Zone connection (I/0s)

7.4
X Zone

o § c

o Ke]

38 g

L S 3

= (@)
RX.8 Relay Out
RX.7 Relay Out
RX.6 Relay Out
RX.5 Relay Out
RX.4 Relay Out
AX.283 Analog Out
AX.13 Analog Out
AX.03 Analog Out
GND GND
QXx.23 Digital/PWM Out
Qx.13 Digital/PWM Out
QX.03 Digital/PWM Out

GNDCOM External Isolated Out GND
24VCOM External Isolated Out Vdc

L

Y

O

><

(=
—

L

FL)
A
><

:\?m}

O
= pnnlog

0 to 10vei
@)
“Digital/Py
AWdc

Led indicator I/Os state

C Zone
29 c
S @ o
Qg B3
[ c
RX.3 Relay Out
RX.2 Relay Out
RX.1 Relay Out
GND GND
IX.5 Analog/Digital Input
IX.4 Analog/Digital Input
IX.3 Analog/Digital Input
IX.2 Analog/Digital Input
IX.1/INT# Interrupt X In
(-)IX.1 GND 10.1
IX.O/INT# Interrupt X In
(-)IX.0 GND 10.0

o
0 to 10Vdc
Digital
3 1o 24Vec
Digital:
5 to 24Vdc
GND
e 165
(De-1X4
(e 1X3
e 1X2
G0 [XI/INT
Q (-)IXL
r‘““f- IXO/INT
{i— (-JIX0
Jliia i

3 See Section 8 to select the correct configuration for outputs.

4 See the Interrupt Equivalence Table.
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Relay Outputs

Analog Outputs

PWM/Digital Outputs

Relay Outputs

Analog Inputs

Interrupts/Digital Inputs (Isolated)

Configuration Switch

(See Section 8 to select the correct

configuration for outputs)
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ZONE ANALOG/DIGITAL RELAY RASPBERRY PIN
" 0.5 0.0 GPI1027
0.6 0.1 GPI026
B 1.5 1.0 GPIO35
1.6 1.1 GPI1025
C 2.5 2.0 GPI1034
2.6 2.1 GPIO5
8 Switch Configuration
8.1 0 Zone: Communications
SWICH CONFIGURATION
1 2 3 4
R&485 X X | OFF| X )
THURXT X X | ON X
RS232 X | OFF X X
TX2/RX2 X | ON X X
EXP 2 X | ON X | ON
OFF ON
1
! 2
®
3
4

RS484/Serial1/RS232/Serial2/EXP2: This switch configuration can be done following the
previous table to select among RS485 or Seriall and RS232 or Serial2 or EXP2 (Expansion shield

2).
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8.2 Analog / Digital Zone
ZONE A ZONE B ZONE C
SWITCH ON OFF SWITCH ON OFF SWITCH ON OFF
NC - - NC - - NC - -

Q0.7 Q0.7 | AO0.7 Q1.7 Q1.7 | Al1.7 Q2.7 Q2.7 | A2.7

Q0.6 Q0.6 | A0.6 Ql.6 Ql.6 | Al1.6 Q2.6 Q2.6 | A2.6

Q0.5 Q0.5 | AO0.5 Q1.5 Ql.5 | Al15 Q2.5 Q2.5 | A2.5

OFF ON OFF ON OFF ON

NC NC NC NC NC NC

A0.7 Q0.7 A17 Q1.7 A27 Q2.7

A0.6 Q0.6 A16 Q1.6 A26 Q2.6

A0.5 Q0.5 A15 Q1.5 A25 Q25

8.3 Relay Zone
ZONE A ZONE B ZONE C
SWITCH ON OFF SWITCH ON OFF SWITCH ON OFF
NC - - NC - - NC - -

Q0.2 Q0.2 | A0.2 Ql.2 Ql.2 | Al1.2 Q2.2 Q2.2 | A2.2

Q0.1 Q0.1 | AO.1 Ql.1 Ql.l1 | A1l Q2.1 Q2.1 | A21

Q0.0 Q0.0 | A0.0 Q1.0 Q1.0 | A1.0 Q2.0 Q2.0 | A2.0

OFF ON OFF ON OFF ON

NC NC NC NC NC NC

A0.2 Q0.2 A2.1 Q2.2 A12 Q1.2

A0.1 Q0.1 A22 Q2.1 A11 Q11

A0.0 Q0.0 A2.0 Q2.0 A1.0 Q1.0

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF,

it can only act as an Analog Output.

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide

this analog output is represented with AX.X, being X any number of the tables above.
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9 1/0 ESP32 PLC 3.3V pins

The ESP32 ETHERNET&WIFI&BLUETOOTH PLC has some of the ESP32 board pins available.
These pins can be programmed according to Raspberry features such as I/O’s operating at 3.3V
or any additional features present in the pins (for example 12C communication in pins SCL and
SDA). As these pins are directly connected to the ESP32 board, they are not as well protected
as the normal inputs. These pins are mainly meant to be used as prototyping.

The Raspberry board available pins are summarized in the table below. In order to access to
these pins some extra considerations must be taken in consideration.

PLC terminal ESP32 pin
SCL GPIO 22
SDA GPIO 21
X1 X1
RX1 RX1
TX2 X1
RX2 RX1
VN SENS VN
VP SENS VP
SO GPIO 19

Sl GPIO 23
SCK GPIO 18
100 GPIO O

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 3.3V.
These terminals provide direct access to the ESP32 board.

There are some special conditions depending on these 3.3V. Now it is going to be shown the
considerations to operate with these pins.

9.1 I2C

I2C communication DOES NOT REQUIRE a pull-up resistor for the ESP32
ETHERNET&WIFI&BLUETOOTH PLC. The pull-up resistor is already implemented in the PCB.

9.2  SPI-MISO/MOSI/SCK

The ESP32 ETHERNET&WIFI&BLUETOOTH PLC pins used for the SPI bus are summarized in the
table below. For SPI bus MISO, MOSI and CLOCK pins are common to all the connected devices
to the ESP32 ETHERNET&WIFI&BLUETOOTH PLC, conversely, each of the connected devices
will have a single and dedicated SS pin.

Function PLC connection
MISO SO
MOSI SI
CLOCK SCK
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10 A Zone Features: Communications & RTC & uSD

10.1 RS-232

For the RS-232 communication protocol there is a switch that affects it. See the Section 8 for
more information.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232
implementation.

10.2 RS-485 (Half Duplex)

For the RS-485 communication protocol there is a switch that affects it. See the Section 8 for
more information.

Using the boards of Industrial Shields, there is a library that simplifies the RS-485
implementation.

10.3 Ethernet

ESP32 ETHERNET&WIFI&BLUETOOTH PLC Ethernet port controller is based on w5500 IC, which
is the compatible IC compatible with Arduino Ethernet2 Shield libraries. All Ethernet shield
Arduino libraries are compatible with the ESP32 ETHERNET&WIFI&BLUETOOTH PLC.

10.4 BLE

This device has got Bluetooth Low Energy provided by the ESP32. It uses the 4.2 BR/EDR
version and BLE. The BLE is optimized for short burst data transmission, it uses the 2.4GHz ISM
Band, 40 channels (w/ 2MHz spacing), the channel usage method of FHSS, the GFSK
modaulation. It has a power consumption of ~0.01x to 0.5x of reference (it depends on specific
usage). It can be used on different network topologies: mesh, broadcast and point-to-point.

10.5 RTC

ESP32 ETHERNET&WIFI&BLUETOOTH PLC RTC Module is based on the DS1307 Chip. This chip
works with the 12C protocol communication, so it is required to have enabled the 12C protocol.

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation
called RTC.

10.6 12C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. A pull-up configuration means
that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case
it reads 3.3V when nothing is connected. The pull-up configuration is stablished by default in
these pins.
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If it is meant to work them as a GPIO at 3.3V, it must be considered that they are pull-up
inputs.

10.7 SPI- MISO/MOSI/SCK

These pins can only work as a 3.3V if the Ethernet protocol is not going to be used. As the
Ethernet protocol uses the SPI to communicate with the ESP32 board, both behaviours cannot
happen at the same time as the Ethernet would not work.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The ESP32 board allows the pins to be set in a pull-up configuration. If not, it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

10.8 uSD

The microSD uses the SPI communication to interact with the ESP32. The SPI protocol is always
enabled, as there are no switches that configure it.

Using Industrial Shields boards there is a library that simplifies the uSD implementation called
SD.

The microSD uage is conditioned by the switch configuration. See the Section 8.

10.9 5G Wi-Fi

The devices of the ESP32 Ethernet & WiFi & BLE PLC controller family have an integrated 5GHz
Wi-Fi specific chip, called 1ISM43340. As you may know, the 5GHz Wi-Fi band is an improved
version of the previous ones, such as the 2.4GHz band, for example.

The 5GHz technology has some advantages compared to the 2.5GHz band, such as 25 non-
overlapping channels, less interference, faster connection speed, and it works with the
updated IEEE standards (802.11a, 802.11n, 802.11ac).

In order to work with it, Industrial Shields offers some example codes located at File ->
Examples of the Arduino IDE after downloading our boards.

& Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the
operation of an online process or machine. Unexpected operation of a process or machine
could result in death or injury to personnel and/or property damage. Before inserting a
memory card, always ensure that the CPU is offline and in a safe state.
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& Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la
carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le
fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un
processus ou d'une machine peut entrainer la mort ou des blessures corporelles et / ou des
dégats matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est
hors ligne et en sécurité.

11 Additional Features

11.1  Expansion modules

This device has a system of 2 optional expansion modules. Each one of them is a click board
that can be selected by the client when the device is purchased:

11.1.1 GPRS

Featuring the quad-band 2.5G GSM/GPRS SARA-G350 module. This module features a full set
of options for the cellular networking and communication, such as the network status
indication, jamming detection, embedded internet protocols, including TCP/IP, UDP, FTP, PPP,
HTTP, SMTP, full GPRS multislot class 10 implementation, and more. Data communication
speed is rated up to 42.8 for the uplink and 85.6 kbps for downlink connection. This module
offers high quality integrated audio interface.

Type 2G GPRS, GSM/LTE

Applications Remote monitoring automation, asset
tracking surveillance, home automation
systems, point of sales terminals, etc.

On-board modules U-blox SARA-G3 series 2.5G GSM/GPRS
celular quad-band module.
Key features GSM Quad-band 850/1900, 900/1800 MHz,
Maximum output power -8dBm, IPv4/IPv6
dual-stack.
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The Digital/Analog I/Os of this device are connected to the ESP32 through 12C, using specific

chips (see the Section 13). Here we have the equivalence tables (using Industrial Shields

libraries, we do not have to consider these equivalences):

12.1 Pin-Out

12.1.1 Analog/Digital Devices Analog I/0s

21

Analog Outputs

PLC Pinout Chip ADDR Chip INDEX

Zone A

A05 0x40 13

A0B 0x40

A0.7 0x40 7
Zone B

A15 0x40

A16 Ox41

AT Ox41
Zone C

A25 Ox41 10

A26 Ox41

A2T Ox41 7

Analog Inputs
PLC Pinout | chip ADDR | Chip INDEX
Zone A
10.7 0x49 2
10.8 0x49 3
10.9 0x48 3
10.10 0x48 2
10.11 0x48 1
10.12 0x48 0
Zone B
1.7 0x49 0
11.8 0x49 1
11.9 Ox4da 3
11.10 Ox4da 2
11.11 Ox4da 0
11.12 Ox4da 1
Zone C
127 Ox4b 3
12.8 Ox4b 2
12.9 Ox4b 0
12.10 Ox4b 1
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12.1.2 Digital I/0s

Digital Inputs
PLC Pinout | Chip ADDR | Chip INDEX GPIO

Zone A

100 ADDR = 0x21 8

101 ADDR = 0x21 4

102 ADDR = 0x21 5

10.3 ADDR = 0x21 3

10.4 ADDR = 0x21 2 -

10.5 GPID =27

10.6 GPID =26
Zone B

11.0 ADDR = 0x21 1

1.1 ADDR = 0x21 0

1.2 ADDR = 0x20 7

1.3 ADDR = 0x20 8

1.4 ADDR = 0x20 5 -

115 GPID =35

116 GPID =25
Zone C

12.0 ADDR = 0x20 4

121 ADDR = 0x20 3

122 ADDR = 0x20 2

123 ADDR = 0x20 1

12.4 ADDR = 0x20 0 -

12.5 GPIO = 34

12.6 GPIO=5

12.1.3 Relay Devices Analog I/0s

Analog Inputs
PLC Pinout Chip ADDR Chip INDEX
Zone A
10.2 Ox49 2
10.3 0x49 3
10.4 0x48 3
10.5 0x48 2
Zone B
11.2 0x49 0
11.3 0x49 1
11.4 Oxda 3
11.5 Ox4a 2
Zone C
12.2 Ox4b 3
12.3 Ox4b 2
12.4 Ox4b 0
12.5 Ox4b 1
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Digital Outputs
PLC Pinout Chip ADDR Chip INDEX
Zone A
Q0.0 0x40 1
Q01 0x40 10
Q0.2 0x40 9
Q0.3 040 I3
Qo4 0x40 12
Q0.5 0x40 13
Q0.6 0x40 6
Q0.7 0x40 7
Zone B
Q1.0 0x40 15
Q11 0x40 14
Q1.2 0x40 0
Q1.3 0x40 1
Q1.4 0x40 2
Q1.5 040 3
Q16 Oxd1 8
Q1.7 0xd1 ]
Zone C
Q2.0 Oxd1 16
Q21 Oxd1 14
Q22 Ox41 13
Q23 Ox41 12
Q2.4 Oxd1 1
Q25 Ox41 10
Q26 Ox41 6
Q27 Ox41 7
Analog Outputs
PLC Pinout Chip ADDR Chip INDEX
Zone A
AD.O 0x40 oD
AD 1 0x40 6
AD2 0x40 7
Zone B
A1.0 0x40
A1 Ox41
Al12 Ox41 9
Zone C
AZ20 Ox41 0A
A2 1 Ox41 6
A2 2 Ox41 7

38



12.1.4 Digital I/0s
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Digital Outputs

Digital Inputs
PLC Pinout |  GPIO
Zone A
10.0 27
10.1 26
Zone B
11.0 35
1.1 25
Zone C
12.0 34
12.1 5

PLC Pinout Chip ADDR Chip INDEX
Zone A
Q0.0 Ox40 oD
Q0.1 Ox40
Q0.2 Ox40
Zone B
Q1.0 0x40
Q1.1 Ox41
Q1.2 Ox41
Zone C
Q2.0 Ox41 0A
Q2.1 Ox41
Q22 Ox41
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12.1.5 Relay

Relay
PLC Pinout Chip ADDR Chip INDEX
Zone A
RO.1 021 4
RO.2 0x21 )
RO.3 0x21 3
RO.4 0x21 5
RO.5 0x40 oc
RO.6 0x40 8
RO.7 0x40 9
RO.8 0x40 oA
Zone B
R1.1 0x21 0
R1.2 0x21 1
R1.3 0x20 ]
R1.4 0x20 7
R1.5 0x40 2
R1.6 0x40 1
R1.7 0x40 0
R1.8 040 0E
Zone C
R2.1 0x20 3
R2.2 0x20 4
R2.3 0x20 1
R2.4 0x20 2
R2.5 Ox41 0B
R2.6 Ox41 oc
R2.7 Ox41 0D
R2.8 Ox41 0E
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PCA9685A

0x40

13 Internal I12C and SPI Connections
—

PCA9685A

0xd1)
( CRYPTOGRAPHY
W5500
= ATECCGE08A
DS3231 R —
ISM43340 MCP23008
0x20

l I I |

ADS1015 }

ADS1015 o

0x48

0x49

Oxda 0xdb

MCP23008
ADS1015 ADS1015

14 Instructions for troubleshooting

Programming with Linux hardly gives any problem but, with Windows or Macintosh can appear
some issues related to firmware compatibility with the Operating System. So, if you have any
problem with Windows or Macintosh, like the system does not recognize the device or a
timeout when uploading the code, it is recommended to install the following drivers and
restart the computer to avoid any related issue. Be careful installing them so you must select
the right version for your OS, CPU architecture and the USB type port that you are using
(2.0/3.0).

14.1 CP210x Driver (for USB 2.0/3.0)

https://www.silabs.com/developers/usb-to-uart-bridge-vcp-drivers

14.2 D2XX Driver (for USB 2.0)

https://ftdichip.com/drivers/d2xx-drivers/

14.3 D3XX Driver (for USB 3.0)

https://ftdichip.com/drivers/d3xx-drivers/
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15 Instructions for interconnection between Industrial Shields
controllers

15.1 RS-232 Communication:

e il

~ T
‘. Another Industrial
FspazPLe Shields PLC

KRFC-6 Ferrite (4 Loops;

SHIELDED CABLE

>

Ferrite KITA Ferrite KITA
GND
12124V

H GND
W 12/24V
.‘\ J A\
1

“
-

15.2 RS-485 Communication:

15.2.1.1 Half Duplex

o
-

o

—

- .
CapsaPLC ‘. Another Industrial
Shields PLC
KRFC-6 Ferrite (4 Loops)
A =~ E - A
SHIELDED CABLE
Ferrite KITA Ferrite KITA
GND ) ~ GND
1o/ mo@ @OOO( 12124
/ / \
. 1 c' 1

b
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15.3 Ethernet

l@l) IIIIIDCIIIIIIIIIII 3t:- l

Ethernet _——

Another Industrial )
EspazPlc O ~ Shields PLC

Ferrite KITA Ferrite KITA
GND 1 GND
12124V >OOC>@ @OOO( 12/24V

For an Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet
crossover cable must be used.
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16 Typical Connections

GND N )00
SM2124V o o j} 0.0
SHIELDED CABLE

Ferrite KITA

SO R Sy

SHIELDED CABLE / Dowrsoad e MDUINO LAYOUT:

PN T

Ferrite KITA

-
&l o POWER
sad B oomaw
SHIELDED CABLE .|| Duunlont 20 MOURO LAYOUT:
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\
SHIELDED CABLE
2124V c/c-. 0.7
GMND
Ferrite KIIA
g e ) ) rower
—J2raN J/ B OOTALANALOG
SHIELDED CABLE ~ /  Fremwemidesssvstoon
< TS

— T2, Lo

010V

Ferrite KITA

GND

\J

224V

SHIELDED CABLE / s \
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SHIELDED CABLE %%
512124V S,
GND
Ferrite KITA
GND
ol
12/24V

Rev. 3:19-11-2021

10.7

SHIELDED CABLE Downioed fhe MOUINO LAYOUT!
i Fromy: www.indusirisishivids.com \

Ferrite KITA

v POWER
224V [ DIGITAL OUT
SHIELDED CABLEf Pt feiadd \_

SHIELDED CABLE

SM2r24v
oA

VOUT = @/ Vde

ALWAYS
CONNECTED
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SHIELDED CABLE

Ferrite KIT/ ®
GND VOUT = 0/ Vde
m{ﬁ

SHIELDED CABLE

DIGITAL / PWM |SOLATED
OUTPUT

* Sow the swilch
configutarion (ON)
Qivde H- 51224V
COM {-) { GND .&
J ALWAYS
JU1 CONNECTED
Ferrite KITA Q0.8 ® SHIELDED CABLE
f: POWER VOUT = Q/ Vde
"'L; I DIGITALFWA OUT

SHIELDED Cﬁﬂlﬂﬂ L e

47



Rev. 3:19-11-2021

* See the switch
configutanion (ON)
— A

ALWAYS

nn CIONNECTED
Ferrite KITA _®_
Mi@] VOUT = Q7 Vide

12724V
SHIELDED CABL \\
\WJ y

SHIELDED CABLE

* Analog Outs no led /

indicator

L T * See the switch
orfo g O configutarion (OFF}
s DRiD

1]

o4 GND .
| T o)

1]

SHIELDED CABLE
=R -
Ferrite KITA \L:’/

(= 9) |} power

224V ) § awaosour

SHIELDED CABLE
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17 Connector details:

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502
from Phoenix contact. MC0,5/10-G-2,5THT

For 1/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference | MC 0,5/10-G-2,5 THT

Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm

Pin dimensions 0,8x0,8mm

Pin spacing 2,50mm

Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?

Rigid conduit section max. 0,5 mm?

Flexible conduit section min. 0,14 mm?

Flexible conduit section max. 0,5 mm?

Conduit section AWG/kcmil min. | 26

Conduit section AWG/kcmil max. | 20
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18 Mechanical Characteristics

- Dimension ESP32 ETHERNET&WIFI&BLUETOOTH PLC:

0
-
8=
<t
- DIN Rail mounting
Profilato o cappello TH 35-7,5 Prafilato o cappello TH 35-15
Top hat rail TH 35-7,5 Top hat rail TH 35-15
155,
RO8
RO
]
=
+ L_
SRS 1=004
Sezione A/ Section A .
o~ 2,2 min. finoa / To 2,5 max
= -
7l
B Sezione A/ Sedtion A
CARATTERISTICHE METODO  UNIA'  BLEND FEATURES TEST UNITS  BLEND
DIMISURA PU/ABS METHOD PUABS
Mecconiche  Reigoreo o tuzioneolo srenomente  ASTM D638 MPo 68 Mechanical fest Resiionce o tesile stess f yield ASTMDS38 MRy 68
Redisoreo o tuzionea nttw ISTIDB3E  MPo 48 Tonglostength ASTMD638 MR %
Allngomento o totin K088 9 i o ASTMD638 % 9
Mool in fesione STADIN _ MPo 2894 Pleing modules ASTADTS0 MR 7894
Pova Iz0d con intoglio 150180/14 X/ 55 rod test noiched 1018014 X' 55
Termiche Temp di nmmolinento Viat, medoB AT DIS2S  °C 114 Thermal fest Vit sodtening tomperctuee method B ASTMDIS2S 114
Tomperoun Ricto 1 81 My K068 °C 91 Rebeting temperatue 1,81 WPg ASTMD848  °C 9
Fisiche Peso gadfin K092 géamd n Physical test  Spaciic gy ASTHDT®? _ géand 12
Riti nello stompo STADSS % 0408 Mould hiinkage ASTMDSS % 0408
Mol Flow Index 260°C - 98N KSTNDIZE  o/10° 111 Melt Flow Ines 260°C - 98N ASTMDIZ38 10’ 11
Comportamento Avbesinguerza (i di pesoe) [I2) - V-0(08) Flome fest Self atinguishr (thidness in mm) L4 - V0(08)
allo fiomma _Fib Incadescen 37 mm 69521 °C 960 Inndestents thiepd 32 mm IEC89521 960
Italtronic si riserva il diritto di modificare il moteriole con cui realizzo i propri prodotti Italtronic con operate ony change of the materials without being obliged to forewam.
senzo obbligo di preawviso.

For optimal operation of the product, it must be located in an electrical cabinet with 1K08
mechanical protection. The minimum IP protection degree required is IP56.
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19 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which is apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the 1/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particle,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the ESP32 ETHERNET&WIFI&BLUETOOTH PLC from heat, high voltaje and eletrical
noise:

Always separate the devices that generate high voltage and high electrical noise from the
ESP32 ETHERNET&WIFI&BLUETOOTH PLC. When configuring the layout of the ESP32
ETHERNET&WIFI&BLUETOOTH PLC inside your panel, consider the heat-generating devices
and locate the electronic-type devices in the cooler areas of your cabinet. Reducing the
exposure to a high-temperature environment will extend the operating life of any
electronic device. Consider also the routing of the wiring for the devices in the electric
cabinet. Avoid placing low-voltage signal wires and communications cables in the same
tray with AC power wiring and highenergy, rapidly-switched DC wiring.
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Provide adequate clearance for cooling and wiring ESP32 ETHERNET&WIFI&BLUETOOTH
PLC. Is designed for natural convection cooling. For proper cooling, you must provide a
clearance of at least 25 cm above and below the devices. Also, allow at least 25 cm of
depth between the front of the modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a
way that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquidfilled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25¢cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess of
temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.
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- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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About Industrial Shields:

Direction: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruités de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com
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Changes
First implementation
Changes on the section 11
Section 15 added

New version changes added
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